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Introduction

Mac Art Dept. was created primarily for people with little
or no art and design background. The disk contains
copyright-free drawings that are yours to use with the
Macintosh computer and the MacPaint program. These
drawings are raw material for you to adapt and alter to suit
your design needs. In this manual, I make suggestions for
possible uses of these images in stationery, letterheads,
business correspondence, newsletters, announcements, or
personal letters. I also show you numerous ways to modify
images; every image may be altered at least twenty differ-
ent ways (which will be discussed in detail later on).
Many of the objects on the disk are drawn only as outlines
so you can choose whether to silhouette them, reduce or
elongate them, drop in a tone or pattern, or use the spray
can to create a form. You can integrate the drawings with
large, complex designs, combine them with the Mac’s var-
ious type fonts, and even enhance your pages with border
designs. The possibilities for creating personalized, dis-
tinctive designs are almost limitless. The powerful features
of MacPaint allow you to make a copy of an image for safe-
keeping and then give you the freedom to improvise and
experiment with various techniques on the original.

While there are no right or wrong solutions to design
problems, I will try to help you understand why some
layouts are more pleasing than others. Some images will
look spectacular when altered in a certain way; others will
be excellent candidates for the trash. The examples in this
manual will also familiarize you with the Mac’s functions
and with the steps used to create certain effects. But
before I get down to the details of using Mac Art Dept., a
little background about the Macintosh is in order.



The Macintosh
era

The Macintosh introduces a new era of affordable, com-
plete graphics systems. Although MacPaint-type programs
have been produced for other computers, the Mac has the
distinction of being the first and best computer in its price
range. Some will dispute this claim, citing the fact that the
Mac does not support color. But while color capabilities
in a low-cost computer may have some useful applications,
for the kind of graphics most people want to create, color
isn’t really practical. Most printed matter is designed in
black and white, simply because it’s faster, easier, and less
expensive. Color reproduction from a computer screen is
expensive and often ends up looking like a poor-quality
color photocopy that’s been left on a busy street corner in
the rain. Furthermore, combining color graphics and
words effectively is difficult.

MacPaint, however, was designed to work beautifully
with MacWrite —in black and white. Imagewriter output
can be photocopied in mass quantities or used as medium-
quality, camera-ready art. Some typesetters will take your
MacPaint files disk (or files sent via modem) and typeset
your material to produce high-quality photostats ready for
the printer. Or you can use a laser printer, if you have
access to one, to produce high-quality output. With these
last two, nearly foolproof, methods, there are no spec
instructions to foul up, no pieces of art to lose. Thus the
Mac is a complete graphics work station that combines all
the drafting tools, photostat machines, and mechanical
boards you need into one small package. The tools at your
command are incredible: you never have to buy erasers,
ink, pen tips, rubber cement, spray mount, T squares, or
French curves, or make runs to the nearest Aqua-lung
dealer for airbrush tank refills. The Mac is an instant, well-
stocked art supply store that, when used with MacPaint
and Mac Art Dept., gives you the freedom to try anything.

Jasper Johns, a pioneer of modern art and one of the
most revered and influential artists of our time, described
art as taking an object, doing something to it, then doing
something to it again. I invite you to do just that, and in
the pages that follow I'll give some advice on how best to
go about it. After all, you are now the director of your own
Mac Art Dept.



Getting Going with
Mac Art Dept.

If you have a Mac without the external disk drive, the first
thing you may want to do is break down and buy a second
drive. Mac Art Dept. does run on a single-drive system, but
in order to transfer images to your MacPaint work disk
from Mac Art Dept., you will have to resign yourself to
constant disk swapping. There’s just no way around it. (To
those of you who have come to hate even the thought of
disk swapping but cannot afford an external disk drive: see
Supermac by Danny Goodman [New York: Simon & Schus-
ter, Inc., 1985] for advice on efficient disk swapping with
a one-drive system, as well as suggestions about how to
make a MacPaint work disk and other useful things.)

Getting a drawing from my disk

to yours

Now, whether you have one drive or two, for a quick demon-
stration of how to transfer a drawing, let’s start with a clean,
new page. From the desktop, simply double-click on the
MacPaint icon in your work-disk window, and a new docu-
ment file will open automatically as the program loads. If you
are already in MacPaint, save and close the current picture,
then pull down the file menu. Choose New and you’re ready
to go. Well, sort of.

You are looking at a blank page, which can be quite
intimidating, so let’s cover it with an image or two from
the Mac Art Dept. To pull drawings from Mac Art Dept.,
first close your empty file. To do this, hit Save or Save As in
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the File menu. A dialog box will appear and ask you to
name the file. Give it an eloquent name; then click on Save
or press Return on the keyboard. Now select Open from
the File menu, and another dialog box will appear.

If you have a two-drive system, insert the Mac Art Dept.
disk in the external drive, and that disk name should
appear in the upper right-hand corner of the dialog box (if
not, click the drive button). Next, select the name of the
file that contains the drawing you want from the scroll
box on the left. (To help you make your choice, the
Appendix in this book shows each file, in a slightly
reduced size.) Now click on Open in the dialog box.

If you have a single drive, you have to take a few extra
steps. Click on the Eject button in the dialog box to eject
your MacPaint work disk and insert the Mac Art Dept.
disk. Select the name of the file that contains the drawing
you want, click on it, and click on Open (you can also
simply double-click on the file name).

Now, whether you have one drive or two, when the Mac
Art Dept. page appears on the screen, use the lasso or
marquee ( called the selection rectangle in the MacPaint
manual) to surround the drawing that interests you. Select
Copy from the Edit menu (always Copy, never Cut). Close
the file and select Open from the File menu. Single-drive
users must now eject the Mac Art Dept. disk using the
Eject button in the dialog box and put their MacPaint
work disk back in. Those more fortunate folks with exter-
nal drives will simply click on Drive in the dialog box,
which will switch them back to the MacPaint work disk.

Next, whether you're using one or two disk drives, click
on the name of your recently titled file, which should
appear in the scroll box on the left side of the dialog box.
Your clean sheet of paper should now reappear. Before
pasting in the drawing you have selected, double-click the
grabber to open Show Page. Once in Show Page, use the
cursor to move the screen rectangle to the place on the
page where you want the image to appear. Once you have
the screen positioned correctly, click on OK. Now select
Paste from the Edit menu. You have just copied your first
Mac Art Dept. drawing,.

I will cover how to move more than one image at a time
(from a single file, or from several different files) a little
later.
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Some general
advice

Before you start manipulating the image you have copied,
here is some general advice that will help you use the Mac
Art Dept. more efficiently. The first and most important
point to remember: always copy, never cut images from
the Mac Art Dept. disk. If you inadvertently use the Cut
function, you can undo the damage by answering “No” to
the “Save changes before closing?” prompt that will appear
when you close the Mac Art Dept. file. For protection,
always keep a copy of the Mac Art Dept. disk in a safe
place —that way, if you cut and lose an image accidentally,
you can replace the image using your backup disk. (Some
of the older DOS System Disks cannot copy a completely
full disk. If you have a problem, either purchase an
updated System Disk or simply copy half of the files onto a
second.) All I ask is that all copies of the disk that you
make be only for your own use. Giving copies away to
friends and acquaintances is illegal—and, for me, may
mean that I'll never get that beach house in Malibu.

Remember also that if you are transferring Mac Art
Dept. images between files and you want to close one file
and open another, you don’t have to exit MacPaint. Simply
select Close from the File menu or hit the close box on
the left end of the title bar. The window and file will dis-
appear, but the menus will remain. You can now open a
different file by selecting Open from the File menu. If you
have a single-drive system and the file you want is on
another disk, you will have to eject the current disk with
the Eject button in the resulting dialog box. Owners of
two-drive systems simply have to click the drive button in
the dialog box to access the disk in the external drive. The
new disk name will then appear in the upper-right corner
of the dialog box.

Another point to bear in mind while using the program:
keep your MacPaint work disk uncluttered so that you
don’t run out of space. If your disk does become danger-
ously full (with only 3K to 50K left), you will get an audi-
ble warning and see a prompt advising you to delete mate-
rial or change disks. If you get to this point, it is best not
to try to continue working, but to stop and move
unneeded files to another disk before doing anything else.
This will prevent the program from performing its most
drastic measure —locking you out—at a critical moment.
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Some MacPaint
Fundamentals

Now you are ready to exercise your creative talents—by
using MacPaint to modify Mac Art Dept. drawings and
make your own designs. Although the MacPaint manual is
clear, it is pretty short. Thus, before we get our hands
dirty, I'd like to add a few more suggestions that should
help you to manipulate the images in this package.

Positioning your drawing

on the page

‘When you enter the Show Page mode, you can move the
image and page in several ways. One way is to position the
pointer in the dotted rectangle and move the window.
The image will stay in the same place on your 8x10 page,
but the active window will cover a different area.

You can also position the image on the page by dragging
the pointer outside the dotted rectangle. A word of warn-
ing, however: if you move any part or all of the image off
the screen, you will erase it when you exit Show Page.
Should that happen, your only recourse would be to revert
to the last version, provided you have already saved the
image.

Incidentally, as you work, it is a good idea to periodi-
cally double-click the grabber to enter Show Page and
simply look at your work as it will appear on the page. It’s
easy to fall into the habit of designing just for the screen
window, which is actually less than a third of the entire
working page.
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Replicating an
image

To replicate an image, first surround it with a blinking
marquee or lasso it. Then place the pointer anywhere on
the image, hold down the Option key, and drag the new
copy to another part of the page. If you want the copy and
the original to line up either vertically or horizontally,
press both the Shift and Option keys as you drag your
copy.

Before working on a particular image, I recommend
duplicating it in this way for comparison purposes. You
can’t be sure how the changes you plan to make will affect
the drawing, and although you can always revert to the last
version you saved, having to do so will mean that you've
lost all your changes since your last save.

To create repeated images for a shadow effect or to use
an image as if it were a brush shape, lasso the image (you
can use the marquee too, but the included white space of
the background usually spoils the effect ), hold down both
the Command and Option keys this time, place the pointer
on the image, and drag it around the page. Vary the speed
with which you make a stroke and note the different kinds
of effects you can create.

Moving an object on

the screen

To move an object on the screen, you can use either the
marquee or lasso icon. While both perform the basic func-
tion equally well, they operate somewhat differently and
each has its own unique capabilities.

The marquee is the more powerful of the two. It allows
you to execute the options of stretching, rotating, flipping,
tracing edges, and inverting an image. Just remember,
though, that as you “rubber band” around an image, the
entire contents of the marquee, including the white space
around the object, is captured. You can also marquee a full
screen if you wish. To do so, simply double-click on the
marquee menu box.

Despite the fact that the marquee has access to a greater
number of options, the lasso has two significant advantages.
One is that it captures only the image in question, with no
background, no matter how complex its shape. The other
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advantage is that you can use it to turn an image into an
overlay (which means the image is transparent, allowing
the background to show through), provided you leave an
opening of at least one pixel in the image’s outline. Since
all the drawings in Mac Art Dept. are fully enclosed, to take
advantage of this feature you must enter the FatBits mode
and knock out an opening. (More on this later.)

Reshaping an
object

When an object is enclosed by the marquee, you can
reshape it in a variety of ways. Take the image you have on
your screen and experiment.

First, place the pointer on the top or bottom side of an
active or blinking marquee (to stretch or shrink an image
vertically) or on the left or right side of the marquee (to
alter the image horizontally). To stretch or shrink along
both axes simultaneously, place the pointer in any corner
of the marquee.

Now press the Command key while slowly moving the
cursor. The enclosed image will stretch or shrink, depend-
ing on what you do. If you hold down both the Command
and Shift keys together and place the pointer in any
corner, the image will still stretch or shrink, but only in
such a way that it maintains the same proportions as the
original.

To toggle between the new shape and the old one, hit the
Command and z keys together (these are the keyboard
equivalent of Undo).

By the way, don’t attempt to use this method to resize
type; the results will be disappointing. Some letters
become heavy, while others stay the same weight. Replac-
ing the lettering with a different font size is the best
solution.

You may also be disappointed by the results when you
try to stretch illustrations of living things. While pictures
of inanimate objects respond fairly well to this treatment,
a “stretched” horse, for example, is likely to become
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unrecognizable. Nonetheless, go ahead and experiment;
your stretched horse might turn out to be spectacular!
Fortunately, you always have the Undo command at your
disposal, so you can return your drawing, animate or inan-
imate, to its original form.

The same principles apply to condensing or shrinking
objects. In general, objects tend to appear more “compu-
terized” as you enlarge or reduce them. Remember, too,
that enlarging an image will often cause it to look bulkier.
Single pixel lines will acquire new pixels in seemingly
random patterns, and a design’s subtlety can easily be lost.
You'll want to keep these guidelines in mind, but don’t
forget, you're the art director, and the drawings are yours
to play with.

Zooming in with

FatBits

MacPaint’s zoom function is called FatBits. This feature
allows you to magnify a pixel (the smallest drawing unit
on the screen) to eight times its normal size, making it
large enough to work with easily. Zooming in on your
work is the best way to clean up and add detail.

To enter FatBits if you are using the pencil, simply posi-
tion the pencil on the place you want to enlarge, hold
down the Command key, and click the mouse. (You can
use this same method to get out of FatBits as well.) If you
are using any of the other tools, simply double-click the
pencil in the tool palette or select FatBits from the
Goodies menu. A magnified version of the section you
have selected (using the pencil method) or of the last sec-
tion you worked on (in all other methods) will appear. To
help you visualize the results of your FatBits artistry,
MacPaint displays a normal-scaled version of the section
currently displayed in FatBits in the upper left corner of
the screen.

All the tools in the tool palette will work in FatBits, but
the tools that are most practical when working at such a
magnified scale are the pencil, grabber, eraser, and line.
You can scroll an image in FatBits by first selecting and
then dragging the grabber, but if you are using the pencil,
it is much quicker to press the Option key. Doing so
changes the pencil into the grabber for as long as you hold
the Option key down.
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Filling objects with

Datterns

The Fill function from the Edit menu (which can only be
used with the marquee or the lasso) and the paint can
icon let you fill an object or entire screen with a tone or
pattern. When using the Fill function or the paint can
icon, however, always make sure that you save your image
immediately beforehand or, at the very least, have a spare
copy of your image next to the first. Do this because,
when using either of these two functions, even the most
seasoned MacPaint users are capable of a simple mistake
that can lead to disaster. What is this mistake? When you
click on Fill or the paint can, you may not see the results
immediately—both Fill and the paint can sometimes take a
few moments to register their results. If you are the impa-
tient type, you may well assume that the first click didn’t
register, and click again. This is not a problem if you made
no mistakes and got the results you were looking for. But
woe is you if you didn’t. If both clicks did indeed register,
the second click undid the Undo function for the first. The
result: your original, premistake version is completely
gone, and your work is ruined. So be careful with Fill or
the paint can— when using them, always wait before
assuming that your nimble fingers didn’t press the mouse
button hard enough.

The most common problem (read: disaster) encoun-
tered with Fill or the paint can is having the pattern leak
out of the drawing and flood the screen. The cause of this
all-too-common event lies in the image you are attempting
to fill—somewhere in its outline there is an opening, a
missing pixel, that allows the pattern to escape. The draw-
ings in Mac Art Dept. are sealed to prevent this, but if you
modify them in any way you should check to be sure that
they are resealed. To do this, position the pencil on the
picture’s outline, hold down the Command key, and click
the mouse button to enter FatBits. Use the pencil to fill in
any holes, and use the Option key to turn the pencil into
the grabber. With the grabber, of course, you can follow
the outline all the way around to check for leaks.

Note that in MacPaint, you have two options using the
spray can or paintbrush with a pattern. One is straightfor-
ward: if you simply hold down the mouse button (without
pressing any keys on the keyboard), the new pattern will
replace any existing pattern on the screen—by stages, of
course, if you are using the spray can. If you hold down
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the Command key while you use either the spray can or
the paintbrush, however, the new pattern will wash over
existing patterns or lines instead of simply replacing them.
The Command key thus gives you the option of using a
pattern as if it were a transparent overlay.

To completely replace an old pattern with a new one,
use the paintbrush (without holding down the Command
key) for complex shapes or the marquee and the Fill
option (from the Edit menu) for very simple shapes.

Creating your own

Datterns

When you’re using the patterns from the pattern palette,
remember that you are not limited to the selection shown.
You can alter any pattern or create entirely new ones.

To create a new pattern, simply double-click on the
existing pattern that you want to alter. This will bring up
an Edit Pattern window showing your selected design
both in regular size and in FatBits (in an 8x8 pixel box—
the basic unit of every pattern). You edit the pattern
simply by clicking pixels on or off with the pointer in the
FatBits version; each change is immediately reflected in
the regular-size version on the right. A little experimenta-
tion will show that even the slightest addition or deletion
will significantly change the look of a pattern. Replace the
old pattern with the new by clicking on OK when you are
done.

If you create patterns that you would like to reuse at
other times, make medium-sized rectangles filled with
your new patterns (one to a rectangle, of course). Create
a document file called Patterns. Follow the usual cut and
paste techniques to save your patterns to the new file,
using the Scrapbook if you have more than one screenful
of patterns to move. (Usually, cut-and-pasted elements are
stored in the Clipboard—but it can hold only one piece at
a time. The Scrapbook, however, is an accessory that lets
you save up to 256 pieces of information concurrently.
More about the Scrapbook later.)

To use one of your newly created patterns in the Pat-
terns file, first copy and paste the rectangle containing the
desired pattern to a blank portion of the page you are
working on. Then position the window so that the pattern
rectangle appears on the right side of the screen. Now
double-click on an expendable pattern in the patterns
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palette on the bottom of the screen to get the Edit Pattern
window to appear. If you then click on the new pattern, it
will replace the expendable pattern in the Edit Pattern
window. Edit the new pattern further, or simply click on
OK and it will appear in the pattern palette. When you are
finished, don’t forget to erase the pattern rectangle. By the
way, custom patterns in the pattern palette are stored
along with the image when you save. Thus, once you
transfer a pattern to a particular file, it will always be avail-
able in that file until you replace it with another one.

Using the
Grid

With some kinds of work, you may want to establish a grid
over the entire screen to help you position images and
type correctly. One way to do this is to use the Grid
command in the Goodies menu, which creates a
marching-step type movement in rather large increments
when you are using the line tool, text tool, lasso, marquee,
polygons, circles, or rectangles. The major problem with
the Grid is that it is invisible, although its effects are
plainly seen.

A visible dot pattern can assist you in ways that the Grid
cannot, such as in dividing images into thirds for full-
screen blowups or creating symmetrical objects or
designs. To set up a one-pixel dot grid, simply select the
widest-spaced single-pixel dot pattern from the pattern
palette and fill the screen. You now have a graph-paper-
like grid of reference points on which to draw or paste an
image. The dots are eight pixels apart and correspond
exactly to the grid points of the Grid option, whether or
not the Grid was in effect when you filled the window.
The only inconvenience of this visible grid is that when
you are done you will have to erase the grid dots by hand.

A final note on using the Grid with patterns: when you
use the lasso or marquee to place an area of pattern next
to another area of the same pattern, the two patterns
probably won’t mesh. As I mentioned, stock MacPaint
patterns, as well as the patterns you have created, are
formed by a repeating mosaic-like block, 8 pixels by 8
pixels. Thus, if you are trying to join one area with another
after a Cut and Paste or a move with either the lasso or the
marquee, to make the patterns properly match at the
seams you have to align the patterned areas both vertically
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and horizontally, so that the two individual blocks of pat-
tern are in sync. Trial and error will eventually reveal the
correct alignment, but an easier way is to use the Grid
function while you position the new area—the Grid
automatically aligns patterns correctly.

The Clipboard and the

Scrapbook

When you cut or copy an image, MacPaint automatically
stores it in what is called the Clipboard. As I mentioned
earlier, the Clipboard has room for only one image at a
time, so it contains only the very last thing that was cut or
copied.

Images will be held in the Clipboard while you change
from a file to the Scrapbook or from one file to another or
from one program to another (such as from MacPaint to
MacWrite ), but when the Mac is shut off, whatever is in
the Clipboard is lost.

If you want to see what is in the Clipboard and you are
in MacPaint (or another application that supports the
Clipboard, such as MacWrite), simply select Paste from
the Edit menu. A copy of the Clipboard’s contents will
appear on the screen—and will disappear when Undo is
selected. If the desktop is on the screen, then select Show
Clipboard from the Edit menu.

I've referred to the Scrapbook several times, so now let’s
take a look at how it works. You'll find it by pulling down
the Apple menu located on the far left side of the top
menu bar. Move the arrow down until it highlights the
Scrapbook and then release the mouse button. The Scrap-
book window will appear, partially covering your work
area. Your Scrapbook may be empty (it will say so if it is),
or it may have text and/or images stored in it. If it contains
more than one item (or page), you can use the mouse to
scroll through the pages by using the scroll bar at the bot-
tom of the window, just as in MacWrite, except that scroll-
ing can be done only in whole page increments. The
Scrapbook will disappear when you click the box in the
upper left corner.

If you are copying more than one item at a time from
Mac Art Dept,, it is most efficient to use the Scrapbook to
hold the images until you are ready to return to your cur-
rent drawing. To place an image in the Scrapbook, simply
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enclose it with the marquee or lasso and select Copy
(remember: always Copy) from the Edit menu. It is now
in the Clipboard. Without closing the file, select the
Scrapbook under the Apple icon. When the Scrapbook
window opens, select Paste and the image will be trans-
ferred from the Clipboard and appear on the first page of
the Scrapbook. To put another image in the Scrapbook,
close the Scrapbook window and select something else
from your file. Copy it, and then open the Scrapbook
again. When the Scrapbook window opens, select Paste.
The new image will appear, on a new page of the Scrap-
book. Although the previous image is no longer visible, it
is still there; the Scrapbook has automatically scrolled
everything back a step—a click on the right arrow of the
scroll bar will bring the previous image back to view. Thus
the latest addition is always the first in the Scrapbook
window.

So long as your disk has the storage space, over 250
images can be pasted into the Scrapbook in this way, and
they will remain there even after you have turned the Mac
off. But accessing a large number of images stored in the
Scrapbook can be tedious. Drawings are stored in succes-
sion, and to find those stored deep in the interior of the
Scrapbook, you must scroll past many others. If you are
manipulating many images, you may want to consider set-
ting up a special file for them. Cutting and pasting
between files may take longer, but the easy access may
well make up for it.

To paste from the Scrapbook to your current file, open
the Scrapbook from the Apple menu and scroll through it
until the desired image appears on your screen. Select
Copy (or Cut if you want to erase the image at the same
time) from the Edit menu. Then close the Scrapbook by
clicking on the close box. Now select Paste from the Edit
menu. The image will appear in your MacPaint window,
enclosed in either a lasso or a marquee (depending on
how it was pasted into the Scrapbook) so you can move it
to the desired spot on the screen.

Erasing your
work

Not everything you do in MacPaint will meet your own
high standards. Therefore, you will, from time to time, find
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it necessary to erase. With MacPaint, you can use several
methods.

The pencil will erase (turn to white) each black pixel that
you click on. (Of course, if you click on a white pixel, it
will turn it black.) If you hold the mouse button down,
rather than just click, it will continue to erase all the black
pixels it encounters as it is moved over the screen.

The eraser from the tool palette will erase larger areas; a
double-click on the eraser icon will erase the entire
screen.

The paint can and paintbrush will erase if you choose
white for the pattern. If you select white as the pattern
and the'dotted line as the outline, any of the filled, solid
shapes in the tool palette will erase an area of the corres-
ponding shape.

Enclosing all or part of an image in a marquee or lasso and
selecting Clear from the Edit menu will erase the selected
area.

Finally, to erase your last action, click Undo in the Edit
menu, or hold down the Command key and hit z.

Printing

When you're ready to print out your work you have two
options. If you select Print Draft, the print head makes one
pass per line. In Print Final mode, the printer makes two
passes and deposits more ink on the paper, resulting in
smoother-edged, darker, and better quality results. Draft
Print is a little cruder; the “jaggies” or stair-step effect on
diagonals is more pronounced.

Print Final obviously takes twice as long as Print Draft,
and for my money, the results usually don’t warrant the
extra time. So long as your printer ribbon is fresh, the
black areas in a picture printed in Draft mode are quite
acceptable. And depending on the quality of the paper, if
you do use Print Final mode, there may be a caved-in look
to the page after the image has been hammered in twice.
The better the paper, the more burnished (and the less
caved-in) the image will appear.

The Imagewriter will handle any kind of paper. If you
want to hand color the design, you should use a good
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quality bond or high rag content paper. The printer will
run paper without sprocket holes along the sides as long
as you feed it into the roller carefully, one sheet at a time.

To print an entire page, simply select Print Draft or
Print Final from the Edit menu (your printer must be
turned on, of course). In a few moments— or twice that
long for Print Final—you’ll have your copy. To print only
the contents of the active window, hold down the Com-
mand and Shift keys while you press the number 4. To
print the entire screen, including the menus, first activate
the Caps Lock, then continue as if you were printing the
active window.

If you want to print more than one page at a time, you
can load a series of documents into the printer by select-
ing the files to be printed from the desktop (hold down
the Shift key and click over the desired files one by one).
Still from the desktop, select Print from the Files menu,
and your documents will be printed (in Final mode) in
the order in which you chose them.
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Manipulating Mac Art
Dept. Images

Now let’s look at some Mac Art Dept. images that I have
modified and added to in various ways. The accompanying
summaries describe how certain effects were achieved
and, in some instances, explain why a particular approach
was taken. Here as well as in later sections, I have also
included some design failures so that you can learn from
my mistakes.

One final note before we begin. The basic tasks we’ll be
performing from now on are duplicating images, moving
them around the screen, filling them with a tone or pat-
tern, blowing them up, shrinking them, and a few other
maneuvers. I recommend that you become familiar with
using the keyboard to perform some of these functions;
you'll find this method much faster than using the mouse
to pull down menus.

The horse in Figure 1a was copied directly from the
Animals file. To create a shadow underneath it, I used the
lasso to make a duplicate horse and then filled the copy
with a dark tone using the paint can (Figure 1b). How-

Figure 1
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Figure 1 (continued)

C D

ever, when I marqueed the shape and compressed it for
the shadow (Figure 1c), the pattern became distorted and
uneven, and began to look like a bad necktie design. To
avoid such problems, try to perform all your manipulations
on an unfilled figure first, and then fill it to get a clean
pattern.

So let’s try again. To get to the image in Figure 1d, the
original horse is marqueed, flipped vertically (using the
command from the Edit menu), and compressed (using
the marquee while holding down the Command key).
Only then was the outline filled using the paint can (yield-
ing Figure 1e)—note the intact pattern this time. The
completed shadow was then lassoed (so that there would
be no white border) and joined to the horse outline (Fig-
ure 1f). Note that even though the images are flat, the use
of the shadow gives the impression that the horse is a
three-dimensional object.

Figure 1 (continued)
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The jukebox used in Figure 2 was copied from the
Music file. The two versions here are simple examples of
using the paint can to apply patterns to parts of a drawing.
Once you have picked a pattern from the patterns palette,
position the paint can icon so that the paint drip is in the
area to be filled, and click once. If you don’t like the
result, simply hit Command-Z to undo the damage, and try
something else.

Figure 2

Figure 3

The dart boards in Figure 3 show two types of negative
images of an object. Figure 3a is the image straight out of
the Sports file. In Figure 3b the image was lassoed and
inverted; Figure 3c is the image after it was marqueed and
inverted. Note that the lasso works only on the object
itself, while the marquee encompasses the surrounding
area as well.
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The golf clubs and bag in Figure 4 are the result of
combining several pieces into one drawing. Separate
images of the clubs and the bag were copied from the
Sports file. The top parts of the clubs were lassoed and
duplicated (by holding down the Option key as the image
was dragged) and then placed “in” the bag by moving
them (still in the lasso) into position. Since the bag is a
contained, outlined shape, it could, of course, have been
lassoed and moved over a cluster of unsevered clubs
instead.

Figure 5 illustrates how to use a single Mac Art Dept.
image that is meant to be cut apart and used according to
your taste or needs. After copying the wristwatch from the
Objects file (Figure 5a), I made a copy and set it to one
side. I decided that I wanted a watch like the bottom half
of the drawing, so I carefully positioned a marquee around
the upper half of the watch and pulled the one half away
from the other (Figure 5b). By clicking on Clear in the
Edit menu, th unlucky upper half in the marquee was
made to disappear. At this stage the eraser was used to
take out the remaining hand of the watch. The lower half
was then marqueed, duplicated, and flipped vertically
(Figure 5c¢), and then the two halves were joined. Hands
were lassoed from the original watch and placed in the
new model for the finishing touch (Figure 5d).

Figure 5
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Figure 6
Figure 6 shows the difference between using the lasso

WW///// and the marquee to overlap an object. Figure 6a shows a

7zl
é//é lassoed image over a tone background. As long as the

/ image is completely sealed, which it is here, the lasso will
/ hold onto the form and the background will show every-
/ E where else. In Figure 6b the hammer was marqueed and

/ . moved over the same pattern. As you can see, a white rec-

/5 . tangle came with it and blocked out a good part of the
background. In fact, one of the easiest ways to create an

2
/;’ ] / original graphic design using Mac Art Dept. is to overlap a
. drawing from one of the files and a simple geometric
% pic g

shape. For example, in all the illustrations in Figures 7, 8,
A and 9, the microphone was merely lassoed and dragged on
top of a simple (sometimes empty, sometimes filled)
shape.

In Figure 7a, I drafted a circle with the thinnest line
width, using the hollow circle tool from the tool palette
while holding down the Shift key (to yield a perfect
circle —you will get a perfect square using the same
method with the rectangle tools). The microphone was
then lassoed and moved onto the circle. In Figures 7b and
7¢, I used the paint can to drop patterns into the circle
before moving the microphone. In Figure 7d I drafted the
triangle using the hollow polygon tool, placed it on top of
the circle, and then positioned the microphone on top of
the two shapes.

Notice that the space between the microphone and its
bracket in Figures 7b and 7c is filled with the background
pattern. Had I simply copied and lassoed the microphone
as it is drawn in the Music file, this area would have
remained white (as it appears in Figure 7a). The secret for

~
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Figure 8
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getting a background pattern into such an enclosed space
is to open a channel to the contained area before you lasso
the object. Let’s look at a couple of examples to see how
this works.

To create the illustration in Figure 8d, I first did some
work on the microphone itself. By carefully erasing the
pattern in the top part of the microphone (using FatBits to
get into the rounded corners) and then filling the area
with a dark cross hatching, I made the head of the micro-
phone a darker shade. Next, I filled the top panel with
black and then opened a small channel through the micro-
phone bracket (Figure 8a) so that patterns could flow into
this area later. I made a large, hollow rectangle with
rounded corners using the appropriate tool from the tool
palette, then lassoed the microphone and placed it on top.
I typed out the station call letters in 12-point, bold
Geneva, marqueed them with as small a rectangle as pos-
sible, and reversed them by selecting Invert from the Edit
menu (Figure 8b). The marquee with its letters was then

dragged over the black panel.
In Figure 8c a pattern was dropped into the rectangle

behind the mike. Even though a channel was opened to
the central yoke area, the dots in the pattern I chose are
so far apart that none of them appeared in this area.
Although the result is technically correct, it looks like a
mistake. In such cases you have two options (whichever
one you choose, hit Undo to get rid of the pattern fill
before you proceed): select another pattern, or move the
entire image a little and try the same pattern once again.
Eventually it will work (see Figure 8d).
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Figure 9

A B C

Not all patterns have to be outlined to give the
impression of a geometric shape. Figure 9c began with a
borderless, filled circle created by using the filled circle
tool combined with the dotted-line border from the
border palette (Figure 9a). The circle was lassoed and
placed over the microphone in Figure 9b, and the micro-
phone was lassoed and placed over the circle in Figure 9c.
Note the different results —I think Figure 9c looks better,
but you may feel otherwise.

By the way, whenever you are doing work that has
definable stages, such as some of the microphone work I
did above, it’s a good idea to save at the end of each stage.
The Undo command will reverse your last command, but
if your last major effort has been saved, you can restore it
after a series of unsuccessful commands by choosing
Revert from the File menu.

The designs in Figures 10a and 10b are built around the
saxophone, which I pulled directly from the Music file.
The music staff lines in Figure 10a were copied from the
same file and stretched lengthwise (by holding down both
the Shift and Command keys while the marquee was
pulled from the right end). The saxophone was propor-
tionately enlarged (using the same technique, except that
the marquee is pulled from a corner) on a different part of
the page, away from the staff lines, then lassoed and tem-
porarily cut from the page. Finally, I scrolled up to the staff
lines again and pasted in the enlarged sax.

To make the checkerboard pattern shown in Figure 10b,
I first enclosed the sax with the hollow rectangle, then
lassoed the box, copied it, and used the Invert function
from the Edit menu to create the negative image with the
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Figure 10

copy. I then duplicated both images several times. With a
little juggling, I arranged the boxes as shown. By the way,
when you use Invert in this way, it is important to check
to make sure your lines are true to your original box,
because creating a negative image causes the black outline
to disappear. You thus lose a pixel or two when you con-
vert from black on white to white on black, and the
checkerboard won’t line up right if you aren’t careful.

The runner in Figure 11 illustrates the use of an image
as if it were a paintbrush. He was cut from the Sports file
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Figure 11

and pasted onto an empty page. To produce Figure 11a,
the dotted line was selected from the border palette at the
lower left corner of the MacPaint screen. The image was
lassoed and the mouse was then dragged from left to right
while the Command and Option keys were held down.
Notice that the copies of the runners are very close
together. In Figure 11b the mouse was dragged at about
the same speed, but here the fattest line width was
selected from the border palette. These are the extremes;
the line widths in between will give varying degrees of
closeness.

Hands, from the Hands & Signs file, can be combined
with other images to a wide variety of ends. The pen in
Figure 12, for example, was lassoed and copied from the
Desk file. A one-pixel break in the outline of the pen was
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made to allow the thumb of the hand to overlap (Figure
12a). The pen was then moved into place using the lasso,

and the image cleaned up in FatBits (Figure 12b).
The airplane in Figure 13 was copied from the Travel

file. Once pasted on a new page, it was flipped horizon-
tally and rotated in a marquee (using the commands from
the Edit menu), and the sign hanging off the back was
erased. The same hand as in Figure 12 was copied to this
page, and openings were made in the tips of the two fin-
gers so that the tail of the plane would overlap the hand.
Since the thumb overlaps the tail of the plane, it had to be
solid, so a line was drawn at the arrow in Figure 13a to
seal it off. The hand was lassoed, placed over the plane,
and the whole thing finally cleaned up in FatBits
(Figurel3b).

Figure 12
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Figure 14

The hammer in Figure 14 was taken from the Tools file
and the hand was lassoed directly on top of it. In FatBits, I
used the pencil to redraw the hammer’s handle where the
lower side of the hand had cut it off.

The drawing of a waiter’s hand holding a tray (Figure
15) is composed of a hand from the Hands & Signs file
(note that this hand could also be rotated to a catching or
stopping position) and a circle created with the circle
tool. To make the oval form appear three-dimensional, the
edge closest to the viewer was lassoed, copied (using the
Option key), and the copy placed just below the original
circle. A couple of pixels were added in FatBits to the
right and left edges and the whole tray was then lassoed
onto the hand. Now the rest is up to you. Any object from
Mac Art Dept. could be lassoed onto the tray.

Figure 15

% —
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Figure 16

In Figures 16, 17, and 18, I built various groupings of
plants and trees out of drawings from the Plants file. The
two roses (Figure 16a) were copied from the file, then
duplicated, and the duplicate flipped horizontally (Figure
16b). All four versions of the rose were then lassoed and
positioned together to create the bouquet in Figure 16c.
This bouquet could be combined with other Mac Art
Dept. images by placing it in a grasping hand, a flower pot,
or the barrel of a gun, to name a few possibilities.

The row of palm trees in Figure 17b was composed by
lassoing the single palm from the Plants file (Figure 17a)
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and making a few copies. To space the trees evenly, the
Grid function from the Goodies menu was used. The
sidewalk beneath the trees was built by using the line tool
to create the shape and filling the center area with a gray
tone, leaving the curb white.

The bare tree and the little squiggles in the box in Fig-
ure 18a were taken directly from the Plants file. Individual
squiggles were lassoed and copied repeatedly onto the
defoliated branches of the tree to produce the pine tree
on the right. Once the tree was in good shape, it was mar-
queed, copied numerous times, and several of the copies
were horizontally flipped. Finally individual trees were
lassoed and combined to make a forest (Figure 18b).

Figure 18
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Figure 19
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non-sealed sealed

The defoliated deciduous tree in Figure 19 was covered
with one of the leaf forms from the box below it (both of
which were copied from the Plants file). The two leaf
patterns are different: the sealed one will carry with it a
white highlight when lassoed (and will not allow the
branches to show through either), while the non-sealed
one will add density to the tree when it is lassoed and
copied. The fully leafed tree to the right in the figure was
made using the non-sealed leaf pattern. It’s a good idea
when working with trees, by the way, to either add or
remove pixels from time to time from the leaf pattern you
are using in order to avoid too homogeneous a look.

The Plants file also contains a complete oak tree, a small
potted shrub, and a boxed leaf pattern. The pattern in the
box can be lassoed and used to make different kinds of
potted (or natural) shrubs or used as an alternate leaf
pattern with the defoliated trees.

Figure 20 Figure 20 illustrates some simple things you can do with
stock borders from the Borders file. The corner shown in
‘M?a Figure 20a is taken straight from the file (and is, by the
A4 way, all you need to build a complete border around a
page—as you will see later on, a little creative copying and
rotating will yield all the necessary parts). Figure 20b is
B the same border with a different pattern replacing the
black of the design, using the paint can and a simple line
pattern. Any border can be given an entirely different look
this way.
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Figure 20c is another stock border, and 20d is the same
border with the solid black areas replaced with a different
(more or less gray tone) pattern. Changes of this sort tend
to subdue a bold border pattern like this one. It may take a
few tries with different replacement patterns before you
find the right look for a specific border. But if you don’t
like your first attempt, just hit Undo and try another.

Replacing the white part of a border pattern is just as
useful, although a bit more difficult to accomplish. For
example, Figure 21a is a stock border, and Figures 21b
and 21c are the same border with patterns from the pat-
tern palette dropped into the white areas. To do this, you
have to either seal off the ends of the border to prevent fill-
ing the entire page, or build the complete border and then
fill in the now completely contained areas. The paint can
is used to fill in in both cases.

Figure 21
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Figure 22 shows several more examples of filled in
white areas (the original border is the one on top); in this
case, the white areas in three of the altered borders were

Figure 22
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already contained, while the white area in the one to the
right was not, and had to be sealed before being filled.
Another straightforward way to alter an existing border is
to lasso and invert it, as in Figure 23.

Figure 23

So far, we have just looked at border corners. How do
you make a complete border from a corner? Figure 24
shows all the parts you need to manufacture a complete
border and the finished product. In this case, the Borders
file provides only one corner and an edge. (In many cases
only a corner is provided; if so, simply marquee and copy
the long side of the corner to make a separate edge
piece.) To make the other three corners, take the supplied
corner and make a copy with the marquee. With this still-
marqueed copy, click on Rotate from the Edit menu to
make the second corner. With the marquee still active,
make a copy of the new corner and rotate that for the
third corner. Now make a copy of the third corner (still in
its marquee) and rotate that one, too. You now have four
different corners (Figure 24). The connecting edges for
between the corners have to be created in the same way
from the one supplied in the Borders file. To make the
edges long enough, stretch them using the marquee
together with the Command and Shift keys. Finally, place
all the parts in their proper places with the lasso—to help
you make seamless connections, you may find it useful to
make your moves with the Grid function on.

Figure 24
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Figure 25

o 0

The filmstrip border in Figure 25 can be manipulated in
the same way as all the other borders, but it also has the
advantage of being able to carry within its individual
frames either many different images or a repeated one.
Just copy a drawing and either reduce it to fit the frame or
enlarge the film window to fit the image. Here the horse
drawing has been reduced and then rotated to fit into the
vertical windows. The image was then lassoed and copied
over into the frames. Once the corner has been com-
pleted, as shown here, then the whole border can be
manufactured as in the previous example.

The spray can and rendered perfume canister in Figures
26 and 27 appear in the Tools file as squashed images in

Figure 26




40

order to save space. The trick to bringing them back to
normal is to pull them apart. Figure 26a shows the canis-
ter as it appears in the Tools file. In Figure 26b, the bot-
tom section has been marqueed (for a clean break) and
moved down on the page. (Press the Shift key as you do so
to keep the parts aligned properly.) A section of the top
part has been lassoed and moved down in Figure 26c. This
lassoed middle section is now repeatedly copied and
dragged to make the container body. Just hold down the
Shift and Option keys while dragging the mouse, repeat-
edly releasing the mouse button and then pressing it again
to drag some more. Make sure the dots in the pattern stay
in register and that there are no missing sections. The final
version should look like Figure 26d.

The same principles apply to the paint can in Figure 27.
The image as it appears in the Tools file is shown in Figure
27a. The lower section has been marqueed and moved
down in Figure 27b. This time, however, the line tool was
used to connect the base with the top since this image is
not filled with a pattern (Figure 27¢).

Figure 27

B C

The nut and bolt in Figure 28a are from the Tools file.
The bolt, of course, needs a little more length. Thus, the
thread pattern has been lassoed away from the head in
Figure 28b, then duplicated and dragged repeatedly using
the lasso with the Shift and Option keys (Figure 28c¢).
(Figure 28d shows what you have to avoid when doing
this: it is important to make sure everything is in perfect
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Figure 28
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register, whether you are repeating images for a
wallpaper-type look, constructing borders, or extending
an object. The threads have not lined up correctly in Fig-
ure 28d, and heavy lines have formed where they should
not have. ) Finally, the nut was lassoed into place (Figure
28e¢) after the far side of it was removed with the eraser
(Figure 28f).

The fat little flashlight in Figure 29a (from the Tools
file) is also intended to be lengthened. Figure 29b illus-
trates the section of the handle that should be lassoed and
repeatedly copied to build a normal-looking flashlight
(Figure 29¢). The pencil and the piece of paper held by
the paper clip in the Desk file are both meant to be
enlarged as well, the latter in order to hold messages.

Figures 30, 31, and 32 illustrate the method I use to
turn a small image into a full-page illustration. I copied the
watch from the Objects file and then used the line tool to

Figure 29
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mark the distance from top to bottom. I did this by draw-
ing straight lines (using the Shift key) out from the watch,
removing them with Undo, and, with the crosshairs still in
the same position, drawing a new, shorter line only part-
way back toward the watch (Figure 30a). I then carefully
fitted a hollow rectangle between the lines and filled it
with the grid pattern (Figure 30b). Small tic marks were
placed at approximate thirds along the grid, the locations
determined merely by counting squares. The bar on the
right-hand side was inserted as a reference line.

Figure 30

In Figure 30c, the top section has been marqueed (care-
fully using all the markings as guidelines). It was then cut
and pasted into the Scrapbook. This procedure was
repeated for the middle section. The last section was mar-
queed and cut (Figure 30d), but only held in the Clip-
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board and not pasted into the Scrapbook. Then the graphs
and other registering marks were erased and the active
window placed at the bottom of the page. (During the fol-
lowing steps, it is useful, although not crucial, to keep the
window centered on the page.)

I double-clicked the marquee icon to surround the
entire window and pasted the bottom portion of the
watch from the Clipboard onto the marquee. By pasting in
this way, the image is automatically enlarged to the size of
the window (Figure 31). Next, using Show Page, the win-
dow was repositioned directly above the bottom section
of the watch, and the middle section was pasted into
another full-window marquee. Finally, the last and top
portion of the image was pasted into place. The seams
were then fine-tuned in FatBits mode, pixel by pixel (Fig-
ure 32). This method can be used to blow up any image
to a full page. It is not perfect, but if you are careful, it
does a pretty fair job. The closer your marquees are to the
proportions of the screen, the less distortion will occur.

ol
Ry
by

bt S

Lt st

Figure 32

=




44

In this example, the numbers on the watch could have
been replaced by large-point numerals and the edges of
the watch cleaned up a bit, but the computerized look of
the whole piece would make the numerals stick out like a
sore thumb. Besides, the way it is now creates a nice con-
trast between an old-fashioned object and a new art form.

To illustrate how all of the many techniques we have
seen affect a single image, I have taken a picture of an ink
bottle and altered it in all sorts of ways in Figures 33 and
34. Figure 33a is the image as it looks directly from the
Desk file. Figure 33b is a proportional enlargement: the
image was marqueed, and with the pointer in a corner of
the marquee and the Shift and Command keys held down,
the mouse was dragged diagonally away from the center of
the rectangle. In Figure 33c, the ink bottle was made pro-
portionally smaller using the same technique, except that
the mouse was dragged inward, not outward. Figure 33d is
a proportional enlargement of the previously reduced
image; the result is a more computerized or graphic
image. The form becomes simpler and the crudeness of
the pixel resolution creates an interesting effect.

Figure 33e is a horizontal stretch enlargement, again
using the same technique as above, except that the poin-
ter was placed on a side, not a corner. Figure 33f was
marqueed and stretched vertically. Figure 33g is a negative
image made by marqueeing the ink bottle and selecting
Invert from the Edit menu. Figure 33h shows the image
after being lassoed and inverted. Most of the image is lost
because the original is almost entirely black. As you can

Figure 33
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Figure 33 (continued)

see from this example, lassoing works most effectively
when there is a balance between black and white in the
drawing.

The image in Figure 33i is the result of using Trace
Edges from the Edit menu on the original drawing (the
ink bottle must be in a marquee in order to do this). Fig-
ure 33j has been hit twice by Trace Edges, so the outline
effect is more evident. Figure 33k is a further alteration of
33j, which was lassoed and then inverted to achieve this
effect.

The Trace Edges function has been used repeatedly on
the ink bottle until it filled the entire marquee in Figure
34a, and Figure 34b shows the original ink bottle pasted
back down in the center of the previous image. In Figure
34c, the ink bottle was lassoed and used as if it were a
brush by holding down the Option and Command keys

Figure 33 (continued)
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Figure 34

while the mouse was dragged. The shape in Figure 34d
was made by lassoing the original ink bottle and selecting
Fill from the Edit menu after selecting a simple, striped
pattern. (If you try this on a marqueed shape, the entire
rectangle will fill with the selected pattern.) Of course,
any pattern from the pattern palette can be used by click-
ing over it before you invoke the command. A diagonal fill
pattern was chosen for Figure 34e, duplicated with the
lasso, then dragged over the original for an overlay effect.
Figure 34f was created in much the same manner; two
shadows were overlayed slightly and the original ink bottle
was then dropped in slightly off-center. This technique
can be used to create a shadowlike effect for many kinds
of illustrations.

My intention for Figures 34g and 34h was to show a

Figure 34 (continued)
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Figure 34 (continued)
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reflective surface with the ink bottle resting upon it. The
easiest way to do this is to make a copy with the marquee
and flip the copy vertically. Then squash the upside-down
image. The final step is to lasso the original and position it
over the reflection (Figure 34g). Figure 34h is the same
basic idea, except that the reflection was lassoed and filled
with a simple pattern from the pattern palette before the
unaltered image was moved over top. Figures 34i, j, and k
have been ghosted by using white in the spray can. This
effect leaves more detail within the image than the
pattern-fill technique. Some images, when ghosted, can
resemble coquille or charcoal drawings.
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Combining Images
and Type

There are no fixed rules for using type in design. Some
layouts, however, are more visually appealing than others.
For example, if you're using a silhouette or a visually heavy
image, a lighter typeface will complement it well. Con-
versely, a light image can be offset nicely by bolder type.
Light type with an outline or light object can be subtle,
but the combination often results in a washed-out appear-
ance. On the other hand, oversized typography combined
with a dark object will dominate the page, perhaps over-
powering your overall design.

Sizing is important, because it relates directly to the
value of objects. Try to vary the size of the objects and
type in your design. Play a large image against small type
or combine small objects with large lettering. But
remember that there really are no rules; sometimes a
design in which all the elements are the same size can be
quite handsome.

To integrate large amounts of text into MacPaint it is
probably easiest to use MacWrite. You can convert an
entire MacWrite screen into a MacPaint document by tak-
ing a snapshot of the MacWrite screen pressing the Shift,
Command, and number 3 Kkeys together. The resulting
snapshot can be loaded into MacPaint and manipulated
there in the usual MacPaint ways (but no longer in the
usual MacWrite ways).

If you do not use the snapshot method, however, and
copy (to the Clipboard) from MacWrite and paste into
MacPaint, type from MacWrite can be realigned to new
proportions by pasting the text into a marquee of approp-
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riate shape. The font itself will not change in size, but the
words will realign to fit the marquee. If the marquee is too
small to hold the entire text, you will lose what cannot be
pasted into it. This method has its limitations and usually
requires some trial and error, but you may find it useful,
since type from MacPaint cannot be altered in this way.

MacPaint’s own text function works well for headlines,
subheads, and other small of medium amounts of textual
material. If you click on the text icon (represented by the
letter A) in the tool palette, a vertical bar will appear on
the screen. Twelve-point Geneva is the default font (the
font that appears automatically when you start MacPaint ),
but you can change fonts easily using the Font menu. The
available point sizes (point size refers to the height of the
letters) varies from typeface to typeface, but can range
from 9-point to 72-point.

The outlined point sizes for each typeface are the ones
in which that type will look best. The solid point sizes will
work too, but these sizes are created by MacPaint —
approximated from one of the outlined sizes—and some-
times come out looking a little bizarre, and in the smaller
sizes the letters sometimes fill in or block up. If you do
want to use one of the point sizes that is not outlined, try
to pick one that is an even multiple or divisor of one that
is. (For example, if the font size 24 is the only one in out-
line numbers, 12 and 48 will look the best of all the ones
listed in solid numbers.)

One final point. When using the text tool, if you have
not set the line permanently (that is, clicked the mouse to
set a new insertion point or selected a new tool), you can
change the style, font, or size of the type in the active line
or lines. Take advantage of this feature to cycle through
the available fonts, font sizes, and font styles to choose the
combination best suited to your current design. Now let’s
look at some sample designs.

The smoke shop trademark in Figure 35d was begun by
copying the pipe from the Personal file (Figure 352). The
best way to start filling in or modeling an image from an
outlined shape such as this one is to put the darkest tones
in first. To do that, you must first decide on the direction
of the light source, which in turn determines which side is
shadowed. In Figure 35b, the right side is in shade, with
the heaviest tones blocked in. The intermediate tones
were added later for the final image shown in Figure 35c.
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Figure 35

o

Charlestoun, A E
617/555-6818

There are, of course, many ways to make a full-tone
rendering. My method was to block in major tone areas
(using the paintbrush with a small brush shape) for the
entire pipe first, instead of noodling in great detail with
one section or working methodically from right to left.
This way, I get a better feeling for the entire shape. If the
drawing becomes too dark, you can take the pencil and
remove pixels, or use white in the spray can and dust over
some sections. With the paint can you can add tone by fill-
ing in areas, providing the borders are sealed —the stem of
the pipe was shaded this way. And remember, it’s always a
good idea to save the image in stages as you progress.

The next two designs (Figure 36) are strong, memora-
ble images for a gardening service, even though most
landscapers now use power equipment. Stacking the type
under the handmower (see Figure 36a) lends a particu-



John Simpson
-Gardener-
919 Willow St.

Chicago,I11.60614

312/555-5555
A

John Simpson 919 Willow St.

Figure 37

Charles O'Neill
47 Parkwood
Garden City NJ
01375
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larly traditional look to the piece. MacPaint lets you do
this easily—you can center lines of type automatically by
choosing the Align Middle option in the Style menu.

Figure 36b is a more fanciful example; here the type is
intended to resemble grass cuttings flying from the back of
the mower. To achieve this effect, the long line of type
was constructed first as two lines, because the whole
address was too long to fit in one window. The type was
then lassoed and moved in stages, using the grabber to
push the page around in the window. To create the flying
grass clippings, I typed the word “gardener” in an open
area on the page, lassoed the individual letters, and
dragged them into place above the blades. The pattern
looks random, but it took some experimenting to get it to
look even semispontaneous.

Chicago,I11.60614. 312/555-5555

The typewriter in Figure 37 (from the Objects file) is a
useful design symbol. Here I drew a white rectangle to
create the piece of paper in the machine, and then
entered the name and address. You can enlarge both the
typewriter and the piece of paper if you wanted to present
more information.

The soccer camp design (in Figure 38) could be used
as a promotional piece. I created it by proportionally
enlarging the ball, which was taken directly from the
Sports file, using the marquee in conjunction with the
Command and Shift keys. I then lassoed the enlarged ball
and repeated the image by holding down the Option and
Command keys. (If you want more control over the
number and placement of repeats, hold down the Option
key only and move the ball, release the mouse button,
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Figure 38

134 CROZET RD 8¢

NEID ORLEANS,LA.

504/555-35555

move it again, release the mouse button, etc.) To ensure a
straight horizontal axis when repeating images such as
this, you can first push the lassoed shape into a corner and
then move along the top or side. If you press the mouse
button and then move the pointer off the screen, the
image is forced to follow the side of the window, and the
repetitions will all be parallel, with the window acting as a
straight edge. The speed lines which overlay the balls are
actually long, thin, white rectangles created outside of the
design and then lassoed into place. Type was created in
unused space above the drawing and also lassoed into
place.

To create the construction company logo in Figure 39a,
I copied the house from the Buildings file and removed

8901 LITTLE AVE. ,COCONUT GROVE,FLORIDA
A
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the chimneys and added shingles to the roof (for no par-
ticular reason). I then made three copies of the house and,
using the marquee, chopped off varying amounts of the
bottom on two of the copies—since this is a logo for a
construction company, it seemed appropriate to reveal
more of the building in each square of the three-part
design. (Actually, one copy of the house would have suf-
ficed; the different sections could have been copied and
moved using the marquee with the Option key.) The dark
background behind the houses was used to offset the
lighter type. The typeface here is New York, in underlined
and outlined style, and each letter is separated by a space
(words are separated by three spaces). A lighter, sans-serif
typeface was chosen for the address and phone number
below.

Another way of manipulating this image would be to
actually build a house in the three frames. To make Figure
39b, the drawing of the house was taken apart piece by
piece with the lasso. The individual elements, such as the
porch and roof, were then cleaned up in FatBits to remove
traces of other elements such as windows and parts of
walls. The stripped-down version was placed in the first
box. For the second, some parts of the house were lassoed
back on. In the final frame, the entire house was used. The
last frame was finished by using the paint can to fill the
roof with a line pattern resembling shingles, to put a brick
pattern on the chimneys, and to fill in the windows. The
light background pattern in each frame adds cohesiveness

Figure 39 (continued)

8901 LITTLE AVE.,COCONUT GROVE,FLORIDA
B
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to the design. The design could also have been created by
working backwards from the complete image, decon-
structing the house using the eraser.

The magnifying glass in the Objects file can be used to
graphically “enlarge” an object or piece of type to empha-
size a point. In Figure 40c, the use of the glass to magnify
the word “mystery” produces an effective logo for this
specialty bookstore. In this example I used the glass from
Mac Art Dept. without any modification. The title and the
store information were set in small New York type; the
“stery” in the word “mystery” was set in 2 much larger,
font size. The glass itself was then masked with a hollow
rectangle (Figure 40a). Using FatBits, I opened a one-
pixel-wide channel from the lens of the glass to the out-
side of the rectangle frame. Then the entire structure was
lassoed and moved over the large “stery;” because of the
mask, the letters only showed through the lens of the
magnifying glass. Once the glass was positioned properly,
the rectangle and channel were removed, the missing

Figure 40
meMystery Bookstore
8914 Calvert Street  Baltimore, MD
ry Bookstore
8914 Calvert Street
Baltimore, MD
The ste Bookstore c

8914 Calvert Street  Baltimore, MD

B



55

pixels were replaced on the frame, and the rest of the text
and magnifying glass were jockied into position bit by bit
(Figure 40b) with the lasso.

To create the dinner invitation in Figure 41b, I filled the
bow tie outline from the Personal file with solid black
using the paint can. I enlarged it, and then used FatBits to

Figure 41

bz 12
thigume 421 Proer 2t SEE5-5585

nner at &000 Bob and Joan
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smooth out the contours. Next, the tie was moved into
position near the top of the page, and a line was sus-
pended from the center of the tie using the line tool with
the Shift key depressed to keep it straight. I then typed out
the letters “RSVP” (in New York bold) and surrounded
each one with a small circle. I marqueed the four buttons,
and used the Invert function to reverse black and white
(Figure 41a). Next, I double-clicked on the pencil to
enter FatBits. In this mode I used the eraser to remove all
the black pixels from around the buttons, which were,
back in normal size, lassoed and moved into position along
the line. The type at the bottom (except for the date) was
keyed in, then put in invert white on black in a long, nar-
row marquee. The cummerbund shape was created from
the top of a large ellipse drawn by the hollow circle in the
tool palette. The upper arc was lassoed and moved to the
top of the rectangle containing the inverse type, and the
resulting white wedge was filled with black. Finally, the
date was typed out, inverted, and moved to the top of the
cummerbund.

The spilled ink in the stationery store logo in Figure 42b
adds a humorous aspect to the design, because the image
it projects is contrary to our expectation—a business like
this should be neat and orderly. I began by copying the ink
bottle from the Desk file. The store’s name was set in a
normal straight line with an additional space between
each of the letters. The curve of the bottom edge of the
ink bottle was recreated by lassoing and copying (by hold-
ing down the Option key) the bottom of it and erasing in
FatBits all but the lowest row of pixels. The label lettering
was then lassoed, letter by letter, to fit onto the curve. The
curve guide was lassoed and a copy was placed above the
lettering, the ends of the curves were joined, to form a
box for the letters, using the line tool, and the finished
label finally lassoed and moved onto the bottle. The ink
blot was then drawn freehand with the pencil, checked for
leaks in the outline by moving along the line in FatBits,
and filled with solid black using the paint can. The rest of
the words were typed, then marqueed and inverted to
make a negative that could be lassoed into position on the
blot (Figure 42a).

When you marquee an image and use the Trace Edges
command, you achieve an effect similar to outline type: a
double line surrounds an object previously outlined by a
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Figure 42

JANSON'S

Chicago N E2590

single line. As we have seen, by repeatedly clicking on
Trace Edges, you can create a ripplelike effect with con-
tour lines filling the marquee to its boundaries. It’s a little
Figure 43 like Op Art—usually more of a toy than a valuable tool,
but at times this effect is appropriate.

I used this technique to produce Figure 43. I made two
copies of the lightbulb (from the Household file) and
used Trace Edges on one of them. If you try it yourself,
you will see that the image gets lost when the edges
repeat inside the form as well as outside. To correct this
problem, you can, as I did in this case, paste an unaltered
image back over the pattern, making the design readable
again. To finish off the logo, I put a box around the type
Gerard Ertigan and set it flush with the larger box containing the bulb.
Sans Frane 1ot 60, The letters GE were typed out in 24-point Athens bold,

415/555-3555 marqueed, and placed over the filament of the light bulb.
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Figure 44

Frernch Dry Clearers
130 Xirng Strest Rest
Tororte, Orntario M8y the
(416} 555-5555

The French Dry Cleaners’ logo in Figure 44 uses the
hanger symbol straight from the Personal file. The towel
was constructed using the line tool and pencil. The type is
bold italic 14-point Venice, center-aligned.

For Figure 45, I copied the station wagon from the
Travel-2 file and placed it, using the marquee, on the far
left side of the window. With the arrow in the middle of
the right side of the marquee, I dragged the mouse (while
holding down the Shift and Command keys) to elongate
the image until it filled the width of the screen. In doing
this, the front windshield and hood became jagged, so I
fixed them up in FatBits. The image was then marqueed
and moved to the top of the window, a duplicate was
made and moved to the bottom of the window, and the
duplicate was flipped vertically while still marqueed.

Figure 45

DELIYERY SERYICE
333-3553
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I opened channels into the windows of the upside-down
image so that they wouldn’t be filled, then lassoed the
image and made it into a silhouette by selecting Fill (with
a striped pattern selected in the pattern palette) from the
Edit menu. After I marqueed the silhouette again, I com-
pressed it by placing the pointer on the bottom edge of
the rectangle and moved it slowly in toward the center of
the image (while holding down the Shift and Command
keys)—if you are following along on your Mac, you should
note how the striped pattern changes and becomes
darker. In this example, the new pattern created during
compression is quite effective. The compressed, striped
shadow was finally moved to connect with the line draw-
ing of the car. This reflection effect is an easy-to-duplicate
trick that can be applied to any Mac Art Dept. image.

The lettering on the car was first typed off to the side of
the image and aligned using the Align Center function. It
was then enclosed using the hollow rounded rectangle
from the tool palette. The rectangle was then lassoed and
placed on the door of the station wagon. An alternative to
the door method would be a sign on top of the car. The
one in Figure 45 was created by first setting the lettering,
then enclosing it in two rectangles built using the hollow
rectangle tool. Another alternative would be to place the
type in a cloud of smoke issuing from the tailpipe. If you
are designing lettering to go with an image, one approach
is to work with the letters outside of the area and then
lasso them in, checking for size as you go along. This is the
process I used in this example. Another equally valid
approach is to type out the message first, then fit your
image around it.

The sunglasses, pulled from the Personal file, in the
mountaineering school logo in Figure 46d, reflect an
appropriately mountainous background. The first step in
creating this design was to copy the mountains from the
Travel-1 file and duplicate them. A mask was built around
the glasses and two small one-pixel channels were opened
from the lenses to the outside of the rectangle (Figure
46a). The whole mask was then lassoed and the left lens
was positioned over a copy of the mountains that had
been previously truncated on the right end so that nothing
would appear in the right lens (Figure 46b). The mask
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Figure 46
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was unlassoed and then the mountain/mask combination
was lassoed again and moved so that the right lens was
properly positioned over the second copy of the moun-
tains (Figure 46c¢). The lasso was undone again, the mask
and the bits of mountain sticking out on the right and the
left were erased, and the channels through the glasses
frame were repaired in FatBits. The shadow-outlined type
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was centered below the image in the usual manner. In
your own work, you can choose anything as a reflection,
but remember that whatever is reflected should look
slightly different in each lens, as it does in this example.

The violin used in the announcement in Figure 47 was
copied —as was the bow—from the Music file and pasted
three in a row. (This same image, by the way, can be
enlarged and used as a cello or bass viola.) The bow was
then marqueed, rotated (with the command in the Edit
menu) into a horizontal position, and lassoed to a differ-
ent place on each violin. Type was handled in two ways:
first the title was set in outline (and placed in a box) to
complement but not detract from the images, then the
location, date, and time were set in a regular type style
above the bows.

Figure 47

Polk Hall
ml 1 Im

N BN ORI PAT TR QUPAREI ]

The composite drawing of noisy objects in Figure 48a
was assembled from items from various files. I positioned
the radio first; then, in the following order, the airplane,
train, and truck. The saxophone was pasted down in a
blank part of the page, and using the lasso, multiple copies
were created by holding down the Option and Command
keys. The multiple copies were lassoed and moved as a
unit over the rest of the images. As I worked, I toggled in
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Figure 48

A

The Los Angeles League for the Hard of Hearing
914 N.Western Blvd.,Los Angeles CA,91408

A

NOISE!

NOISE!

and out of Show Page to see how the overall design was
progressing, since only part of the design could be worked
on at a given time.

The word “NOISE” was set in 48-point Chicago.
Because the “jaggies” were rather pronounced at this size,
I used FatBits to clean them up. The stair-steps on the N
and S were leveled off (Figure 48b) using the line tool as a
guide. Next, the entire word was marqueed and stretched
to make it taller. To create even more of a sense of aggra-
vation, the word (still in the marquee) was subjected to
the Trace Edges feature from the Edit menu. The block of
type was then lassoed in close to the airplane.

To get the plane to overlap the letters, I lassoed the
drawing and moved it over the type. Since the entire piece
was, at this stage, larger than a single window, I actually
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lassoed a section of the whole, and then moved the rest of
the drawing, in pieces, up to meet it. This is easy to do. I
lassoed the right-hand part of the drawing and moved it to
slightly overlap the type. After it was in position, I scrolled
the window down using the grabber, lassoed the lower
right-hand section, and moved it up to the rest of the
drawing. And so on with the left side. Cutting apart and
joining sections in this manner is not difficult. The lasso is
the best tool to use for this purpose; it makes an irregular
cut that can be fit back in place in only one way—like a
jigsaw puzzle. Just slowly move the lassoed piece back into
position, release the mouse button, and check for a proper
fit. If it’s not right, simply hit the Undo and try again.

LN

The boot logo in Figure 49a was made by manipulating
type in a trial and error fashion around the drawing from
the Personal file. Figure 49b is an example of the same
object shrunk in size, repeated, and used to create a
border. The “rubber stamp” of the two boots in Figure
49c was created by rotating a copy of the boot, boxing the
two boots in a hollow rounded rectangle, filling the box
with a snakeskin pattern, and placing the whole thing over
a shadow. Boxing things into a rectangle with rounded
corners is a useful device for designing logos, trademarks,
or company identity symbols. It’s probably the simplest
way to create a design using the Mac Art Dept.
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Full Page
Designs

For some final examples of ways to use images from Mac
Art Dept. files, let’s look at some full page designs.

Figures 50, 51, and 52 are letterheads for a travel
agency. I started the major image of the three planes used
in all three letterheads by copying the plane from the
Travel-1 file. Next I created a duplicate plane, for safety’s
sake. Then I stretched the marqueed plane vertically. I
made a duplicate of the now somewhat fatter plane, and
cut it in half by placing the marquec over only half the
plane and then moving the marquee to one side.

I moved the front of the split plane to the left side of the
page and the back of the plane to the right side, and posi-
tioned the complete plane in the center. Toggling in and
out of Show Page mode (by double-clicking the grabber)
helped to space out the planes evenly.

My design intent here was to convey the constant
movement associated with travel activity. While the first
two versions (Figures 50 and 51) are reasonably success-
ful in this regard, the last letterhead (Figure 52 on page
67) is an example of overkill —there is just too much
going on here. The suitcase containing type would be fine
by itself, but the two ideas together bludgeon the travel
theme. The moral of this story: don’t be heavy-handed. Let
a simple idea breathe.

Other ways to approach this design problem include
printing the company name on the side of an enlarged air-
plane, or using the plane as a border or as a “ghosted” wall-
paper design covering the entire page.
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Figure 50

Laurence Travel

12-33 Broadway

Astoria.New York
718/555-8282

The woman’s name written in lipstick in Figure 53 (page
68) was created by first clicking the paintbrush icon twice
(to call up the Brush Shape display) and choosing the
largest round shape, and next lightly scripting the name in
black. I then copied and pasted the lipstick case and cover



Figure 51

into the corner. The script appeared too dark at this point,
so I lassoed my first effort and used the Fill command (in
the Edit menu) to set the letters in a lighter tone.

The graphic trick of placing a shadow behind an object
and slightly off-center is called a drop-shadow technique.
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Figure 52

. | Laurence Travetl ) |
[ [12-33 Broadway| |
. [Astoria.New York !
| ?18/555-8282 | |

Any object in Mac Art Dept. can be treated this way. An
example is the telephone notepaper shown in Figure 54
(page 69). The original telephone image comes from the
Desk file. To make the shadow, I created a silhouette of
the phone by lassoing a copy of it and filling it (from the




Figure 53

Edit menu) with black. With such a complex form, this
method of filling a solid shape is much simpler than trying
to use the paint can to fill in each separately-contained
area. However, channel openings in the receiver and cord
were necessary to keep the open areas in the phone image
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Figure 54

white (Figures 55a and b, page 70). The next step was to
lasso the line drawing of the telephone and move it over
the shadow (the channels in the phone are necessary for
this step as well ). Once these operations were complete
(Figure 55c¢), pixels were replaced or removed in FatBits
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Figure 55

TELEPIONE MESSOGES

(TELEPOONE MESSDBES)

QELEPHONE MESSAGES)

D

to get rid of the channels and clean up both the phone
and the shadow.

The type for the label was Geneva bold outlined; the
blank for the label was made of separated halves of a circle
connected by straight lines. The type was lassoed into the
label, which in turn was lassoed and placed over a pre-
viously filled copy of the label (Figure 55d).

The bull in the financial newsletter title page in Figure
56, which looks somewhat like the Merrill Lynch bull, was
copied from the Animals file. The concept here, placing
one object so that it faces in a different direction from a
group of similar objects, is a great way to attract attention.
All you need to do is marquee any object, from a toaster to
a fish, then select Flip Horizontal from the Edit menu. In
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Figure 56

THE COHEN FINANCIAL NEWSLETTER

this example, I filled in the herd of bulls with the paint
can and a gray pattern. The type here is New York, under-
lined with a second underline, which was added with the
line tool. The type was set on two lines in one window,
then lassoed and moved to fit on one line across the
whole page.
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Figure 57

- 1|
UNITED ASSOCIATION OF ELECTRICAL WORKERS LOCAL 117
BOROUGH HALL, 1743 LINDON AYENUE, GLOUCESTER MASS.

Figure 57 is a union local letterhead that uses unaltered
drawings right out of the Tools file. The cord is merely an
extension of existing lines, with the corner constructed in
FatBits. The type could be placed almost anywhere in this
design: along the cord, as it is here; on the outlet; or
between the plug and the outlet.




Figure 58

“Buggs“Berger
Exterminator ,
1915 University P1.

NaleoniniAy

In the exterminator’s stationery, shown in Figure 58, I
copied a bug, strangely enough, from the Insects file and
then spray painted it with white to fade the image. For an
all-over design like this, I created a stamp with the lasso
and used it to copy the image over and over to make the
pattern. The stamp actually consisted of a group of three
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insects: you need at least three objects to lay out a full
page of properly spaced images. Of the three, two must be
on one line and the third above or below. This configura-
tion gives you both the vertical and horizontal alignment
necessary to work up, down, and across the page. Each
time you move, one of the objects in the stamp of three
should overlay an existing object on the page. In other
words, one object becomes the registration mark for the
other two. If care is taken to drop the new item exactly on
top of the existing one, the spacing will be perfect over
the entire page.

Since it’s impossible to paste something half on and half
off the screen, which you would need to do to repeat the
pattern all the way to the edge, a single line border was
drawn to act as a margin for the page. Stamped bugs that
went over the margin were cleaned up with the eraser
along the outside of the border. Another suggestion: try to
keep the cutoff on the repeated object symmetrical on
both sides of the page. You can always break up the page
with asymmetrical type or by placing an object at the top
of the page. Also, remember that when you place type on a
page like this, a white area travels with and around each
letter, isolating it from whatever it is placed over. Thus
you need not worry about the underlying pixels interfer-
ing with the text.

The palm tree grouping in Figure 59 is a hotel/restau-
rant letterhead. I copied the group of four trees directly
from the Plants file and pasted it five times in an even row
across the bottom of the page. The type was set using the
space bar to separate each letter by one space and each
word by two. The words were typed on two lines in one
window, then marqueed, inverted, and finally lassoed into
position at the bottom of the page.

To create the diner menu in Figure 60 (page 76), I
copied the condiments and napkin holder from the Food
file. I then marqueed the grouping and reduced it propor-
tionately (by placing the pointer in a corner of the mar-
quee and pressing the Shift and Command keys while
dragging the mouse ). Once reduced (you need only
release the mouse button when the reduction is complete;
you don’t need to turn off the marquee ), the image was
proportionately enlarged back to its original size. This
technique produces a hard-edged, slightly abstracted look.
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Figure 59

Here, it was successful; it created a nice architectural feel-
ing. The borders were constructed from scratch and man-
ually turned inside out at the corners. When building the
border in this example, the Grid function in the Goodies
menu was helpful for properly locating the corners as I
went along.
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Figure 60
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To create the Bazaar Trading Post letterhead shown in
Figure 61, I copied the elephant from the Animals file. A
gray tone pattern was dropped in using the paint can after
sealing off the right tusk in FatBits (a number of the small
white areas must be filled in separately). Next, a perfect
circle was drafted by using the circle tool while holding
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hgure 61
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1923 ANACAPA STREET
SANTA BARBARA, CAL IFORNIA
805/ 595-5555

down the Shift key. This circle was filled with the pattern
that resembles basket weave, using the paint can. The ele-
phant was then lassoed and positioned over the circle.
Finally, this combined symbol was marqueed and reversed
with the Flip Horizontal function to make its counterpoint
“bookend.”
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The store name was typed, marqueed, and then
stretched vertically. (Although I already mentioned that
stretched type is usually best avoided, if you have a need
for it you will find that vertically-elongated type works
much better than horizontally-extended type. The verticals
remain the same width when you elongate type and can
come out looking rather well—when you stretch type
sideways, the letters tend to bulk up unevenly and usually
look rather messy.) The frame around the type was made
of two hollow rectangles (from the tool palette), one
inside the other, with one pixel separating them. In Fat-
Bits, a black pixel was placed between the two rectangles
at every other interval, giving the border a checkerboard
look. The elephants were moved apart with the lasso, and
the rectangle containing the type lassoed into place
between them—the tusks had to be redrawn to overlap
the frame. Finally, the address and phone number were
typed using the Align Middle command, and then lassoed
into place.
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Appendix
Mac Art Dept. Files

(Listed in Alphabetical Order by File Name)

America
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Important! Read Before Opening Sealed Diskette
END USER LICENSE AGREEMENT

The software in this package is provided to You on the condition that You agree with SIMON & SCHUSTER, INC.
("S&S”) to the terms and conditions set forth below. Read this End User License Agreement
carefully. You will be bound by the terms of this agreement if you open the sealed
diskette. if You do not agree to the terms contained in this End User License Agreement, return the entire product,
along with your receipt, to Simon & Schuster, Inc., Computer Software Division, 1230 Avenue of the Americas, New
York, New York, 10020, Att: Refunds, and your purchase price will be refunded.

S&S grants, and You hereby accept, a personal, nonexclusive license to use the software program and associated
documentation in this package, or any part of it (“Licensed Product”’), subject to the following terms and conditions:

1. License
The license granted to You hereunder authorizes You to use the Licensed Product on any single computer system.
A separate license, pursuant to a separate End User License Agreement, is required for any other computer
system on which You intend to use the Licensed Product.

2. Term
This End User License Agreement is effective from the date of purchase by You of the Licensed Product and shall
remain in force until terminated. You may terminate this End User License Agreement at any time by destroying
the Licensed Product together with all copies in any form made by You or received by You. Your right to use or
copy the Licensed Product will terminate if You fail to comply with any of the terms or conditions of this End User
License Agreement. Upon such termination You shall destroy the copies of the Licensed Product in your
possession.

3. Restriction Against Transfer
This End User License Agreement, and the Licensed Product, may not be assigned, sublicensed or otherwise
transferred by You to another party unless the other party agrees to accept the terms and conditions of this End
User License Agreement. If You transfer the Licensed Product, You must at the same time either transfer all
copies whether in printed or machine-readable form to the same party or destroy any copies not transferred.

4. Restrictions Against Copying or Modifying the Licensed Product

The Licensed Product is copyrighted and may not be further copied without the prior written approval of S&S,
except that You may make one copy for backup purposes provided You reproduce and include the complete
copyright notice on the backup copy. Any unauthorized copying is in vioiation of this Agreement and may also
constitute a violation of the United States Copyright Law for which You could be liable in a civil or criminal suit.
You may not use, transfer, modify, copy or otherwise reproduce the Licensed
Product, or any part of it, except as expressly permitted in this End User License
Agreement.

5. Protection and Security
You shall take all reasonable steps to safeguard the Licensed Product and to ensure that no unauthorized person
shall have access to it and that no unauthorized copy of any part of it in any form shall be made.

6. Limited Warranty
If You are the original consumer purchaser of a diskette and it is found to be defective in materials or
workmanship (which shall not include problems relating to the nature or operation of the Licensed Product)
under normal use, S&S will replace it free of charge (or, at S&S's option, refund your purchase price) within 30
days following the date of purchase. Following the 30-day period, and up to one year after purchase, S&S will
replace any such defective diskette upon payment of a $5 charge (or, at S&S's option, refund your purchase



price), provided that the Limited Warranty Registration Card has been filed within 30 days following the date of
purchase. Any request for replacement of a defective diskette must be accompanied by the origina! defective
diskette and proof of date of purchase and purchase price. S&S shall have no obligation to replace a diskette (or
refund your purchase price) based on claims of defects in the nature or operation of the Licensed Product.

The software program is provided “as is” without warranty of any kind, either
expressed or implied, including but not limited to the implied warranties of
merchantability and fitness for a particular purpose. The entire risk as to the quality
and performance of the program is with You. Should the program prove defective,
You (and not S&S) assume the entire cost of all necessary servicing, repair or
correction.

Some states do not allow the exclusion of implied warranties, so the above
exclusion may not apply to You. This warranty gives You specific legal rights, and You
may also have other rights which vary from state to state.

S&S does not warrant that the functions contained in the program will meet your
requirements or that the operation of the program will be uninterrupted or error free.
Neither S&S nor anyone else who has been involved in the creation or production of
this product shall be liable for any direct, indirect, incidental, special or consequen-
tial damages, whether arising out of the use or inability to use the product, or any
breach of a warranty, and S&S$ shall have no responsibility except to replace the
diskette pursuant to this limited warranty (or, at its option, provide a refund of the
purchase price).

No sales personnel or other representative of any party involved in the distribution of the Licensed Product is
authorized by S&S to make any warranties with respect to the diskette or the Licensed Product beyond those
contained in this Agreement. Oral statements do not constitute warranties, shail not be relied
upon by You, and are not part of this Agreement. The entire agreement between S&S and You is embodied in this
Agreement.

. General

If any provision of this End User License Agreement is determined to be invalid under any applicable statute or
rule of law, it shall be deemed omitted and the remaining provisions shall continue in full force and effect. This
End User License Agreement is to be governed by and construed in accordance with the laws of the State of New
York.
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REPLACEMENT ORDER FORM

Please use this form when ordering a replacement for a defective diskette

A. if Ordering within Thirty Days of Purchase

If a diskette is reported defective within thirty days of purchase, a replacement diskette will be provided free of charge. This
card must be totally filled out and accompanied by the defective diskette and a copy of the dated sales receipt. In addition
please complete and return the Limited Warranty Registration Card

B. If Ordering after Thirty Days of Purchase but within One Year

If a diskette is reported defective after thirty days but within one year of purchase and the Warranty Registration Card has
been properly filed, a replacement diskette will be provided to you for a nominal fee of $5.00 (send check or money order
only). This card must be totally filled out and accompanied by the defective diskette, a copy of the dated sales receipt, and a
$5.00 check or money order made payable to Simon & Schuster, Inc.

NAME
ADDRESS.

cry STATE zp
PHONE NUMBER ( |
PRODUCT NAME MAC ART DEPT
ORIGINAL PURCHASE DATE
PURCHASE PRICE
COMPUTER BRAND MODEL

Please send all requests to Computer Software Division, Simon & Schuster, Inc., 1230 Avenue of the Americas, New York,
New York 10020; ATTN: Replacements

NOTE: Simon & Schuster reserves the right, at its option, to refund your purchase price in lieu of providing a replacement
diskette.

54317-2

LIMITED WARRANTY REGISTRATION CARD

In order to preserve your rights as provided for i the limited warranty, this card must be on file with Simon & Schuster
within thirty days of purchase.

Please fill in the information requested:
NAME

ADDRESS.

CITY. STATE 2P,
PHONE NUMBER { )
NAME OF PRODUCT. MAC ART DEPT ]

DATE OF PURCHASE PURCHASE PRICE
COMPUTER BRAND. MODEL

DOS VERSION. MEMORY. K

Where did you purchase this product?
DEALER NAME

ADDRESS.

CITY. STATE. 2IP.
How did you learn about this product? (Check as many as applicable.)

STORE DISPLAY___________ SALESPERSON_________ MAGAZINE ARTICLE__________ ADVERTISEMENT.
OTHER (Please explain).

How long have you owned or used this computer?
LESS THAN 30 DAYS_____ LESS THANG6MONTHS_______ 6 MONTHS TO A YEAR_...___ OVER 1 YEAR.
What is your primary use for the computer?

BUSINESS. PERSONAL EDUCATION, OTHER (Please explain).

Where is your computer located?

HOME. OFFICE. SCHOOL OTHER (Please explain),

54317-2



TURN YOUR MAC INTO A PROFESSIONAL ART DEPARTMENT

= Do you find drawing with a mouse difficult?

= Do you have problems mixing graphics and text effectively?
= Do you find Macintosh clip-art products hard to work with?
= Do you want to improve your graphics abilities?

FINALLY, CLIP ART BY A PROFESSIONAL ARTIST

Created by a prominent designer and computer graphics artist, The Mac Art
Q ' Dept. is exactly what the frustrated Macintosh owner needs. It contains a full
disk of versatile, reusable graphics elements and a comprehensive manual with
easy-to-follow step-by-step instructions. With them, you will be able to create
simple yet elegant designs for reports, charts, correspondence...in fact, any
! printed material.

READY-TO-USE GRAPHICS FOR EVERY PURPOSE

The Mac Art Dept. disk contains over 150 graphic images, each one ready to be
used as is or modified to fit your needs. Each image was chosen for its graphic
impact and its usefulness in a wide variety of situations. The images include
household objects (such as a camera, a radio, a bicycle), travel images (boats,
trains, cars), food (an ice-cream cone, a roast turkey), Americana, musical
instruments, buildings, simple and ornate borders, fill-in-the-text signs, and
much, much more.

CREATE NEW-IMAGES FROM OLD—AVOID BAD DESIGN

The Mac Art Dept. manual is a comprehensive guide to using these images and
creating striking graphics designs. It shows you how to create new images from
old ones by modifying them, simply and easily, to suit your individual circum-
stances. Equally important, it gives pointers on how to mix graphics and type,
and provides lots of good advice on how to steer clear of bad design.

PUT A PROFESSIONAL ARTIST INTO YOUR MAC

g Tom Christopher, a highly regarded New York graphics artist, created the

o designs and wrote the manual for The Mac Art Dept. He is a contrlbutor to PC
~ Magazine, and his graphlcs and art have appeared in People, Fortune, Motor
Trend, and other magazines, on NBC News, ABC Sports (including the 1984

- Olympics), and on the covers of records from CBS and books from many major
= publishers.

Requires a Macintosh with a minimum of 128K and MacPaint. 54317
Printer recommended.

Computer Software Division

Simon & Schuster, Inc. 0

Cover design © 1985

by Robert Anthony, Inc. 7671403995

0585 3995 $39.95 LS8N 0=E?1-543L7-E



	1
	3
	4
	5
	7
	8
	9
	10
	11
	12
	13
	14
	15
	16
	17
	18
	19
	20
	21
	22
	23
	24
	25
	26
	27
	28
	29
	30
	31
	32
	33
	34
	35
	36
	37
	38
	39
	40
	41
	42
	43
	44
	45
	2020-07-19-0001
	2020-07-19-0002
	2020-07-19-0003
	2020-07-19-0004
	2020-07-19-0005
	2020-07-19-0006
	2020-07-19-0007
	2020-07-19-0008
	2020-07-19-0009
	2020-07-19-0010
	2020-07-19-0011
	2020-07-19-0012
	2020-07-19-0013
	2020-07-19-0014
	2020-07-19-0015
	2020-07-19-0016
	2020-07-19-0017
	2020-07-19-0018
	2020-07-19-0019
	2020-07-19-0020
	2020-07-19-0021
	2020-07-19-0022
	2020-07-19-0023
	2020-07-19-0024
	2020-07-19-0025
	2020-07-19-0026
	2020-07-19-0027
	2020-07-19-0028
	2020-07-19-0029
	2020-07-19-0030
	2020-07-19-0031
	2020-07-19-0032
	2020-07-19-0033
	2020-07-19-0034
	2020-07-19-0035
	2020-07-19-0036
	2020-07-19-0037
	2020-07-19-0038
	2020-07-19-0039
	2020-07-19-0040
	2020-07-19-0041
	2020-07-19-0042
	2020-07-19-0043
	2020-07-19-0044
	2020-07-19-0045
	2020-07-19-0046
	2020-07-19-0047
	2020-07-19-0048
	2020-07-19-0049
	2020-07-19-0050
	2020-07-19-0051
	2020-07-19-0052
	2020-07-19-0053
	2020-07-19-0054
	last

